Installing the WinTV driver and WinTV
v7 application

Install your WinTV products. Turn on your Windows XP, Vista or Windows 7 based
PC, and boot into Windows.

For Windows XP installations:
After you install your WinTV device and Welcome o the Found New
boot Windows, a 'Found New Hardware' Hardwaro wizard
wizard will appear.

Please cancel it and allow Windows to
load fully before proceeding. With
some WinTV products, you might see this
message two or three times. Please click
‘Cancel’ each time you see the New
Hardware Wizard.

Found New Hardware Wizard

DVD Drive (D) WINTV7_x

Insert the WinTV Installation CD-ROM in
your PC’s CD-ROM drive. [F] Always do this for software and games:
. ) Install or run pvngramf!nm/
For Windows 7: You will see an AutoPlay [TV [
. Published by Hauppauge Computer Works
message. Click Run Setup.exe Generaloptions

{7 Open folder to view fies
l using Windows Explorer

For all versions of Windows: The
“Hauppauge WinTV Installation CD-ROM”
window will appear on the screen. e — EES

N ote: if the CD does not Hauppauge!
autorun, navigate to the :

CD and run the 'Setup.exe'
file.

View more AutoPlay options in Control Panel

Step 1: Install Drivers

Step 2: Install WinTV

Step 1. Install the WinTV
driver

Click the button labeled Step 1: Register )
Install Drivers. E;‘i’t""se cD WIHTV v7
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Drivers have been updated Successfully. Changes wil take effect AFTER YOU RESTART your computer. <<click to exit»

A blue screen will open and begin installing the drivers for your WinTV.

Once the drivers have installed, a message will appear saying ‘Drivers have
been updated successfully’. Click on the bar to exit. You do not need to reboot
your PC until after Step 2

ote: the latest driver updates are available at:
www.hauppauge.com in the Support section.

Step 2: Install the WinTV applications
Click the button labeled Step 2: Install WinTV The setup application will then open

and begin automatically installing the WinTV application components. Once com-
plete, click OK then Exit.

ote: Save your WinTV Installation CD! You will need it if you down-
load new WinTV applications in the future.

Running WinTV for the first time

To run the WIinTV v7 application for watching TV, recording
videos and playing them back on your PC, double click on the
WinTV icon on your

Windows desk top. % Device Setup Wizard

When you run WinTV for
the first time, the WinTV
Device Setup Wizard HaUP.D"aUger The Device Setup Wizard has detected a new device that needs to be setup
appears. Select the TV
source that you are using.
On some model WinTVs,
you have multiple tuners
and therefore you can
select multiple sources. For
the WinTV-HVR-2250, you
can chose either ATSC or TV for the digitl generation

Device Setup Wizard

Device: - WinTV-HVR-9500 (D00DFEODD000)
Please select the types of channels pou wouid ke to setup:
[] Digtel ATSC
[] Digital @AM
[ Analog TV (Cable/fintenna)
[ Extemal Inputs (Compasite/S-Videa]
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Digital QAM and Analog TV. You cannot chose both Digital ATSC and Digital QAM.

N ote: If you'd like to use the A/V inputs, please see instructions below
in External audio/video sources.

If your TV source is ATSC digital over-the-air TV

Select Digital ATSC and click Next. In the ATSC Setup menu, click Next. You
will see the Digital ATSC
Scan scanning for digital
over-the-air channels.

= Device Setup Wizard E‘E‘E‘

Digital ATSC Scan
The digital TV scanning
process will scan from chan-
nels 2to 51. As TV chan-
nels are found, they will
appear in the Channel box.

When complete, click Next /
Next and OK.

Hauppauge! Scan complete

Charrel

211 WLMW-SD  (ATSC Digital Television)
212 CREATE  (ATSC Digial Television)
213 WORLD  (ATSC Digtd Television)
671 WFTY DT (ATSC Digil Television)
251 WNVYET [ATSE Digital Television)
252 WNYE2 IATSC Dighal Television)
411 WHTV-DT  [ATSC Digial Televisior]

Note: {f you do not
receive any ATSC

digital TV channels, an

antenna signal booster might be needed. After adding a signal booster,
see below for instructions on rescanning and the Troubleshooting section
for information on choosing an antenna.

If your TV source is Clear QAM Digital Cable TV
Clear QAM digital cable TV
channels are those TV chan-
nels broadcast on a digital
cable network which are unen-
crypted (‘free to view’). If you
are using cable TV with clear
QAM programs, chose Digital
QAM and Next.

QAM channels which are
detected but are encrypted
are automatically not selected.
The resulting channels in the

P Device Setup Wizard [@EE]
Digital QAM Scan

Hauppauge! Scanning physical channel 100
~ Channel A

[] #2038 Urknown 8295 (PEG2 5018296 - enciypied)

[] #2082 Urknown 8282 (PEG2 SD1 8282 - enciypied)

[] #2085 Urknown 8285 (MPEG2 5D 82.85 - enciypted)

[] 230 Urnknown 82301 [MPEG2 5D 82,301 - encypted)

[] H2302 Urnknown 82902 [MPEGZ2 5D 82,302 - encrpted)

[ 2076 Unknown 8276 (MPEG2 §D 8276 - enciypied)

[ #2107 wiBC+ (MPEG25D 83107)

[7] #2133 CREATE (MPEG2SD 83133

2707 WABCHD IMPEG2 5D 83707)

] WLIW-SD  (MPEG2 5D 83.721)

WABChow  (MPEG2 5D 821081

WORLD  (MPEG2SD 83 132)

128 channels found

v

THE DIGITAL GENERATION
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list might be both standard and high definition channels.

If your TV source is Analog cable TV

Select your Country and your Ersmesmymm [AEE
TV Source from the drop
down list. To automatically
scan for channels, click Next Hauppauge! Please selectthe oty ring satings:

Courty:  [USA,

Analog Tuner Setup

to continue.

Source: Catle

Click the Scan button and
WinTV will automatically scan
for analog channels. The scan-
ning process takes about 10
minutes.

Please select how pou want to enler your channels:
Charrels: | Scan For Chamnels ~

Add Composite/S-Videa inputs s channels

External audio/video ‘

sources

You can bring video into the [~ et ==
WinTV from an external
audio/video source such as a
cable TV or satellite set top box. Hauppauge! Flease seletyourcounty, and he st enatle

. . Courtry: Unted States 7]
In the Device Setup Wizard, e .

External Inputs Setup

select External Inputs and - e

click Next.

You will be presented with the

option to add a Composite and

an S-Video Input. Please select | =

your country (if not correct) and
click Next.
If you wish to connect a source not normally designed for operation in your coun-

try, you can configure the Video Format manually from the drop down list. Change
the value from “AUTO”.

Note: Pal BGHIDK is the commonly used format in Europe. NTSC is the broad-
cast format used in North America.

Rescanning TV channels or adding an external A/V source
If you want to rescan for TV channels or add an A/V source (on those products
with an external A/V input), click the Configuration menu (Gear button in the
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lower left corner of WinTV v7).

Then click on the Devices fah. Choose your WinTV device by clicking on it, then
click Tuner setup. Chose the TV format you want to scan, then click Next. Click
Next and a new scan will be started. When the scan is complete, click Next / Next
and OK.

Using the WinTV v7 application

To watch TV, click the Wateh TV button.

To see the TV Channel list, click your right mouse button in the TV window to
display the Options menu. Select Find Channel. You will see the channel list.

To display the channel list all the time, while the channel list is displayed, click the
Channel list display always on button.

Options menu
The Options menu is the main menu where you can select channels, turn on
close captions, open the TV Scheduler, show the TV Guide and many other of the

WinTV v7 1021 =25 WCES-HD]

al
Current channel Channel list display always on 1
name and number - - Fast channel select
numbers

E TV Channel list

ek,
Configuration 1 —

menu
(Settings menu)

Program Info Record/Pause/Play

controls ol s
Playback file menu nal:lnl}emaulléls‘

Channel

Close captions up/down

Watch TV




Options menu
click your right mouse button to view

Open File. g
ety [~ Playhack menu

Find Charnel

vewwe | Channel list
Aspect Ratio »
Audio Stream »

Scheduler  ~age)
T Guce [~ TV Scheduler

Show Captions
Play —~—

Fause Close captions
Stop

Stay On Tap

Configuration € ‘\

About

=0 Always on top

most important TV control functions.

To bring up the Options Menu, click your right mouse button once in the TV
window .

To see the channel list, click on Find channel. You will see the list of channels
which have been scanned.

To show the Channel menu as part of the TV window, click the Channel list
always on icon at the top of the channel list.

To turn on Close captions, click on Show Captions.

To manually schedule a TV recording, or to see which programs have been
scheduled, click on Scheduler.

To turn on the Always on Top mode, click on Stay on Top.

Watch, Pause and Record TV

WinTV v7 is always recording video to your PC’s hard drive while TV is being dis-
played. In this way, you can immediately skip back and replay the TV program
you are watching.

Clicking on the Pause button will cause the video to pause, while clicking the
Record hutton will cause the current TV program to be recorded to hard disk.
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Skip Skip ) SKEP
back 1 back 10 Time bar  ahead 30  Skip
minute  seconds seconds ahead 1
minute

Program Plaxhack Stop
info

Settings Record Pause/Play

Recording your TV shows
If you want to record a TV show you are watching:

- Click the Record button. The recorded file name will popup on the video for a
few seconds as the recording starts.

- When you are finished recording, click the Stop button.

- Click the Playback file button and select the last file recorded to play the video
you just recorded

- To play a video you recorded earlier, click the Playback File button and then
move your mouse and click once on the video you want to play. Click Open and
the file will start playing.

The recorded video file is saved in the directory set in Recordings directory direc-

tory which can be found in the Configuration menu. The default directory is

MyVideos. To change this directory, click the Settings button and then the Folders

tah. Every time you record a file, a new file is automatically created. The file will be

formatted as (ChannelNumber)_(ChannelName)YearMonthDay_Time.

For digital TV programs, the quality level recorded is the same as it is transmitted by

the TV station. For example, if the TV station is transmitting a high-definition program,

WinTV will record the program in high-definition.

Close captions, parental control information and SAP audio are recorded with digital

TV programs.

For analog cable TV using the built-in hardware MPEG-2 encoder, the quality of the

video recording is set to 6Mbits/sec. This will be a configurable setting in a future

version of WinTV v7.

If you want to pause a TV show you are watching:
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- Click the Pause button. Your TV video will stop and the Time counter will start
counting.

- To start the video from where you paused, click the Play button
- To rewind the video to the beginning, click the SKip to the beginning hutton. if
your video was paused, click the Play button.
- To rewind the video 1 minute, click the Skip back 1 minute
button. If your video was paused, click the Play button.

The Delay counter displays how much time you are behind the live video. For
example, if the delay counter says 00:01:23, then the video window is showing
video 1 minute and 23 seconds behind live video.

Configuration menu

The WinTV v7 Configuration menu is accessed by clicking the gear button in
the lower left hand corner of WinTV v7.

General tab: you can set the Video Renderer which allows WinTV v7 to display
video with a wide range of graphics systems.

auppauge!

General | Folders | Devices | All Channels | Favorites | Parental Control | Advanced Options

Version
WinTV v7.0.27245
Copyright @ 1998-2009 Hauppauge Computer Works
All Rights Reserved
Languages
User Interface Language: English v
Preferred Audio Language: English v| [0 Use SPDIF Output
T [E] Show Captions
Video Renderer TV Shape
@) overday () VMR7 () VMR @ EVR ® 43 @ 189
[] Use hardware acceleration when possible [¥] Lacked window aspect ratio
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Devices tab: allows is where you can re-scan for TV channels and set up the TV
sources in WinTV v7.

Parental control tab: is where you can set the Parental Control level.

Advanced options: you can set options
such as Convert TV recordings to
.MPG file type and Game mode here.

Selecting FM radio programs
On those WinTV products which support FM
radio, if you have scanned for FM radio staions
in the section entitled “Using WinTV for the first USpo
time” you can change the WinTV v7 application e
to FM by clicking FM radio in the Source
selector, found in the upper right hand corner
of the WinTV application.

IR blaster in WinTV v7

If you would like to use the Hauppauge IR blaster (on those WinTV models with IR
blaster built-in) to change the channels on your cable TV or satellite set top box,
see the section entitled “Configuring the remote control for WinTV v7”.

WinTV v7 TV Scheduler

WinTV v7’s built-in TV Scheduler allows you to schedule the recording of TV
shows. Once a record event is set, WinTV v7 can be closed and will “wake up” at
the desired time and tuned to the desired channel.

When a scheduled record event takes place, the WinTV v7 application records “in
background” so that you can continue to watch your live TV program, even as the
recording progresses.

The TV Scheduler can be found in the WinTV v7 Options menu. Right click
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your mouse button in the TV
window to see the Options
menu. Click Scheduler. To set up
an event for timed watching or
recording, click the Add button.

The items that need to be set for
each event are:

- Name: you can add a name
to the recording. If you do not
enter a name, the name will be
in the channel/date format.

- Channel: chose one of your
scanned channels.

- Start time: set to the desired

B2 WinTV Scheduler

Fending Recordngs | TV Guide

A
21.2 CREATE

Next Run Time. D
472212008 700:00 PM oo

uration mIrfo

Frogra
21.2 CREATE

Delete

start time. Click on the hour to set the hour, the minute to set the minute. Note: It
takes about 15 seconds to launch the WinTV and start recording.

- Duration: number of minutes in the recorded program.

- Recurrance: one time, daily, weekly. Note: If you set for Record Weekly,
you must also specify the Day of the Week for the recording.

- Date to Begin Program: today's date is the default. Change this if you want to

schedule on another date.

- Source selection: leave set
at WinTV to bring up the
WinTV at the requested time
and on the requested channel.

Once these are set, click OK. You
can add more recordings, clicking
OK after each event is set.

When you are finished click
Close. The WinTV program does
not have to be running for the
Schedular to work. If WinTV is
not running, it takes about 15 sec-
onds to start WinTV and to start
the recording of TV.

Charingl & Time
Name:
Chaninet
Start Time:

Duratian [mins];

Recurance
@) Rrecord Once

Start Date:

End Date:

=2 Add / Edit Recording

2 211 WLW-SD (ATSC)
122500 % |
EIE

) Record Daly (O Resord Weskly

[einest, id Z 20 ]

X/

page 10



WinTV v7 keyboard shortcuts

Ctrl A
Ctrl D

Ctrl F
Ctrl Z
Ctrl O

Ctrl S
Ctrl W
Alt F

Alt M
Alt P
Ctrl Q

Aspect ratio Ctrl P
Display the video and Alt R
audio format of the TV Alt S
program

Freeze the video AT
Open TV Scheduler Ctrl C
View program details Cinll =
(digital TV program, Ctrl <
where provided in the

broadcast)

Display subtitles
Full screen toggle

Open File menu for
playback

Open the Task Menu
Previous channel

Pause
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Start TV
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Troubleshooting

Some notes on system compatibility

Decoding high definition ATSC TV is very CPU intensive. A graphics card with at
least 64MBytes of memory and the latest graphics driver from the manufacturer
makes the decoding task easier. Typically a 2.2 GHz Pentium 4 processor or
equivalent with a graphics card having 64MBytes of memory is required to proper-
ly decode ATSC digital TV on your PC. A 1.6GHz AMD Sempro laptop computer
tested in the Hauppauge lab used 50% of the CPU for playing ATSC 640i format,
and 90% of the CPU when playing ATSC 1080i, the highest definition ATSC for-
mat.

In some cases, either a faster processor or more graphics memory might be
required. Slow or jerky video and a noisy TV picture indicate system performance
problems.

Jerky video with live ATSC or QAM digital TV

Jerky or distorted video can be caused by two things in your PC or laptop: a slow
CPU which cannot decode the ATSC TV signal fast enough, and a graphics sys-
tem which cannot keep up with the high datarates of digital TV.

Many times, improving the performance of the graphics display will fix the jerky
video display of ATSC digital TV. Here are some tips on improving graphics per-
formance:

- Use the latest graphics driver: graphics drivers are often ‘tweaked’ to improve
performance, especially the built-in graphics on laptops. Check the Microsoft
Windows update site to download the latest graphics driver for your computer. For
Dell computers, check the Dell website for the latest graphics driver.

- Use WinTV v7 Video Renderer settings to optimize graphics performance: The
Video Renderer is found in the General tab of WinTV v7, and is used to change
the display mode of a graphics card for TV watching. This setting does not affect
any other Windows program.

The default mode is EVR. The other modes are VMR9, VMR7 and Overlay. Each
mode uses a different process to render video. Try each mode and use the one
which gives you the best results.

To use hardware graphics acceleration, put a check in the tick box Use hard-
ware acceleration when possible. This will allow your graphics system to use
hardware acceleration for video decode. Note: graphics hardware acceleration
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General | Folders | Devices | All Channels | Favortes | Parental Control | Advanced Options |

Version
WinTV v7.0.27278

Copyight © 1938-2008 Hauppauge Computer Works
Al Rights Reserved

[7] Check oniine for new versions
Languages
User Inierface Language

Preferred Audio Language: [2] Use SPDIF Output

Prefered Subtile Lang [Z] Show Captions
Video Renderer TV Shape

©) Ovelsy ©) VMR7 ) VMRS @ EVR 043 @ 163

[7] Use hardware acceleration when possible Locked window aspect ratio

does not work on all systems.

If this setting does not help, or if you experience WinTV not responding after a
channel change, then your graphics system cannot use hardware graphics accel-
eration. In this case go back to settings and uncheck “use hardware acceleration”
and rerun WinTV.

Only some channels are found during ATSC channel scan

If you are only receiving some known TV channels when scanning, it means your
TV antenna is not adequate to pick up the channel. You will need either an anten-
na signal booster (a Radio Shack antenna amplifier will work) or a high gain
antenna. Here’s a link to an ATSC antenna selector:

http://www.antennaweb.org/aw/address.aspx

Black window when selecting an ATSC channel

If analog channels are displayed correctly but you see a black window when
selecting an ATSC channels, this means that WinTV is not getting a signal. This is
most often due to poor reception. See “Only some channels are found during
ATSC channel scan” above.
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Uninstalling the WinTV driver and applications

Run the hcwclear.exe from the installation CD. Select OK A black screen will
briefly appear and once it has disappeared the software will be removed. If you
now re-start the computer you will be at Step 4 of the installation.

The Hauppauge Remote Control
(optional on some models)

The WinTV remote control software is installed automatically during the installa-
tion of the WinTV applications.

You will see the WinTV Remote icon in the Device Tray. The installation will add a
shortcut to IR.EXE to the Startup group, so that IR.EXE is loaded every time after
Windows has booted.

If you need to restart the remote control, select Restart IR from the Start | All
Program Files\WinTV directory.

Please ensure the following before trying to use this option:

1. Infrared Remote control - has batteries inserted
2. Infrared-Receiver, is fully connected to the IR socket of the WinTV-Card
3. Infrared software is started - The IR icon is on the start bar

To start WinTV press the GO button and a menu will appear. Use the scroll up and
down button to select WinTV and press 0K to select.

Remote control buttons
Go button: launches WinTV.
Power button (green): close WinTV or launches Windows Media Center.

TV button: when WinTV is running, hitting the TV button causes WinTV v7 to go
to “live mode” and turns off recording or pause.

Red record button: starts recording using the parameters set in the Pref menu.

Pause button: if watching live TV, will pause the video. When recording, this but-
ton will pause the video but WinTV will continue to record. If playing back video,
this button will pause the video playback.

Stop button (square icon): stops live TV, the recording or playback.
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Play button: plays the

last video recorded. Go button Apg',:?g}fm”
Back/Exit button: will
close the current menu or v

exit full screen mode.

0 - 9 buttons: When in
“live” TV mode, is used to  Back/Exit
directly enter channel button
numbers. When playing
back a recording, the “1”
button will skip to 10%,
the “2” button 20%, etc.
of the length of the

button

recording.
Skip ahead button: skip %ﬁ?&?
ahead 30 seconds. Play

Skip back button: skip
back 30 seconds.

Go button: Start WinTV.
Menu button: opens
channel list.

Red button at bottom:
Full screen TV

Green button at bot-
tom: not currently used
Yellow button at bot- :
tom: not currently used .- G ;-} Subtitle

Blue button at bottom: button
not currently used

FaSt ey

buttons

- Red
Sub/CC (#): Sub- Halppauger Green
titles on / off Yellow
Blue
buttons
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Configuring the WinTV-HVR-1850 and
WinTV-HVR-2250 built-in IR blaster for
use with WinTV v7

The IR Configuration Utility is used to configure the WinTV-HVR-2250 and
WinTV-HVR-1850’s built-in remote control IR blaster for use with either WinTV v7
or Windows Media Center.

ote: the remote control is initially configured for Windows Media
Center. If you want to use the IR blaster with WinTV v7, you must run
this utility.

To run the IR configuration utility, go to the WinTV program group and click on
HCWCIRConfig_Tool.exe (this file can also be found on the WinTV V7 installation CD
in the MISC folder).

To configure the IR blaster for use with WinTV v7, remove the check from
the box labeled Hauppauge WinTV.

To configure as a Windows Media Center remote control, put a check in the

One Media Center remote control receiver has been detected.

1l Select it to enable remote control of Media Center.

| ¥ Hauppauge WinTv-HVR-2250 (3891)

OK - Save Changes Cancel - Discard Changes ‘

box labeled “Hauppauge Consumer Infrared Receiver”
Click OK to save the changes.

Note: your computer must be restarted for the changes to take effect.

Setting up the IR Blaster for use with WinTV v7

In WinTV v7, the IR RemoteBlaster lets the WinTV-HVR board change the chan-
nel on a satellite or cable TV set top box by transmitting ‘channel change’ com-
mands to the box via an Infra Red (IR) transmitter.
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[ Blaster Config (]

Region

| North America ]
Device Type

| satellite -
Vendor / Model

[ Alphastar El Ellas.ler F'o‘.rt
CodeSet @ Port 1t

| o j IR Channel Test

| Testnen.. | 123 Send
Testall | Advanced Config | 7.1.27070

API=1.0, FW=0.1.0

Note: You will need the remote control from your set top box to com-
plete the configuration in this section.

Note: this proceedure is only necessary if you are using WinTV v7. If
you are using Windows Media Center, it will configure the IR blaster
automatically

The WIinTV-HVR’s IR blaster function consists of two components:

1. IR Blaster cable. This cable has an IR cable jack and an IR transmitter. The IR
cable jack plugs into the back of the WinTV board, and the IR transmitter needs to
be positioned over the IR receiver on your set top box using the self stick tape
supplied on the front of the transmitter.

2. IR Blaster Config program (BlastCfg.EXE) for configuring the codes for the IR
transmitter.

During the installation of the WinTV applications from the Installation CD-ROM, the

Hauppauge IR Blaster applications will be automatically installed.

Every time you boot Windows, the IR32 application should automatically run. You

will notice a small IR icon in your system device tray.

The IR Blaster Configuration program

The IR Blaster Configuration program allows you to choose the cable TV or satel-
lite set top box to control, or to “learn” a new set top box. The IR Blaseter
Configuration program can be found in the Program Groups / Hauppauge
WinTV. Run BlasterCfg.EXE
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To set up the IR Blaster, see the guide
IRRemoteBlaster Quick
Installation Guide for WinTV v7.

Learning remote control
codes for your set top box
First make sure the WinTV IR trans-
mitter is positioned over the remote
sensor on your set top box.
Remember, the WinTV IR transmit-
ter has a very short transmission dis-
tance and needs to be positioned
over the remote sensor on your set
top box.

To access the learn function in
BlastConfig.exe, click on Advanced
Config and Learn.

You will need to ‘learn’ the 0 through
9 keys, plus Power on and Enter. To
learn the new keys:

- hold the remote control from
your set top box as close to the
IR receiver and learn sensor
as possible

s sty T W
Language | [ Version
T 7.1.27107

API=1.0, FW=0.1.0
OK
Region
Leaming ~
Device Type Send button
Settop Box -
Vendor / Model l
e - Blaster T
[UserLeame ~| { S d ‘
CodeSet
10000 o IR Channel Test
i TestNext s |
TestAll Advanced ©onfi

Min DigistoSend [2 [0 Tuning Delay (ms)
Inter-DigitDelay (me) [100 [0 single
Power On Delay (ms) [s00 [~ Send Fove
KeyDelay(msy [ [ Send Enier'at,

Load Defaults Save Settings

Key numbers

ol

2
5

LeamKey(1)
Press and hold bution again

5
4
Leamkey(1) succeeded 7

8
on [0

Leamning Acion ——|

Message hox

 gend

& Leam ‘

- in the Blaster config program, click the button you would like to learn (for

example: 1)

- then depress and hold the corresponding key on your set top box remote con-
trol. You will be instructed in the message box when to release the key onyour

remote control.

- Do this for the keys 0 to 9 plus On and Enter
You should receive a LearnKey(key#) Succeeded message. Then move on to

the next key.

If you receive a LearnKey(key#) Failed error, this means that the key was either
held down too long, or not long enough, or that the remote was not held close
enough to the IR sensor on the HD PVR. Try again.

Once you are finished with the numbers 0 to 9 and On and Enter, you can test
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the learning by clicking the Send button in the Blaster Configuration program. It
will send the numbers 123 to your set top box. Your set top box should now be
on channel 123.

Close the Blaster Configuration program and your configuration will be saved.
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